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First of all I wish to state that there is no reason whatsoever for producing a detailed problems list for meleagrine software
products. Word 3.01 is definitely worth buying, and is a major advance over version 3.0, but some problems remain, and
there are features I would like to see in future versions. On a 1-10 scale similar to that used by InfoWorld I rate Word 3.01 at
about 7.5, which few products exceed.. Word is very good, but it should be better.

Word 3.02, which is now available, which only adds support for the GCC Personal Laser Printer, The LaserWriter SC, and
the Apple ImageWriter LQ printer. If you own one of these printers call Microsoft, and they will send you the proper update.
In the absence of reports of other changes I will assume that the same list applies to both versions except as noted. It is really
very nice of Microsoft to not change anything else and thereby force owners of Word 3.01 to order the newer version.

I will update this document as needed. I will maintain the order of the items until the next version of Word is released The
opinions expressed in this document are my own.

Microsoft responded to a few of the items in this list. Their responses are included with the items in a contrasting
type style. They claim they are seriously considering all reported bugs and suggestions.

A. Bugs and design errors in Microsoft Word version 3.01

1. Word totally and grossly disregards the guidelines for printing in  Inside Macintosh, and Technical Note 95, with
consequences less severe than with version 3.0, but still noteworthy:
a. Manual Feed does not remain selected for the ImageWriter after printing.
b. The serial printer drivers supplied with Word work only with Word.
c. Using a reduction percentage on a LaserWriter, or the 50% reduction or Tall Adjusted options for the ImageWriter

is a major hassle. These options have been improperly moved from the  Page Setup dialog to the  Print dialog.
Word does not adjust its rulers for these options, an action which version 1 did properly. If you use  shift-Page
Setup in order to set the effective page size properly with a reduction, Word does not propagate the reduction
percentage to its Print dialog, and the printing does not line up correctly. A good test for this and some other Word
3.01 bugs is to try to properly convert technical note 45, from its Word 1 format to a Word 3 version that will print
properly. I have not yet been successful.

d. The Factional Widths option is wrongly placed in the Print instead of the Page Setup dialog.
e. Using Chooser to switch printers, especially after having printed a document, within Word can cause printing to

fail until you quit from Word. I have unable to reproduce this, but have received reports of this problem from
multiple sources.



\
f. Word version 3.01 does not work properly with the ImageWriter LQ, the LaserWriter SC, and the GCC Personal

Personal Laser  Printer.  Version 3.02, adds support  for these printers.  Does Microsoft  plan to produce a new
revision every time a new Macintosh printer is announced?
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Word must be modified to  never change the value of any field in a print record that does not have a permanently
assigned a meaning for all present and future print drivers, except via the active print driver's own dialog boxes and
interfaces. There is an explicit warning on page II-150 of Inside Macintosh that attempting to set fields, other than
those specifically allowed can produce unexpected results. Of course, it is perfectly proper for Word to add items to the
dialogs,  or display a supplemental  dialog,  as  described in Macintosh Technical  Note 95,  but Word's  replacement
dialogs must be totally eliminated.

2. Word 3.01 always considers page 1 to be the first page of a document - even when it is not. When printing on a
LaserWriter with the  Print Back to Front option enabled, printing will stop at page 1 of the last section with the
Restart at 1 page number option set.

This problem can be bypassed by specifying a page range including section numbers.

3. If a page or column break, generated by Word, occurs between paragraphs, Word properly ignores the Space Before
specification for the next paragraph (at the top of the page) only if the current section has 1 column per page. If the
current section has 2 or more columns, Word creates a improper blank space at the start of the page or column. Word
does properly honor the Space Before specification for a paragraph following a user specified break.

Microsoft has replied that this is a deliberate feature intended to vertically align the text at the top of each
column and will  cause a smaller loss of control and functionality than not honoring the space before.  I
disagree with this contention. Honoring the space before results in undesired white space. I normally special case the
first paragraph of a section to have no space before. Remember that this problem applies only to column breaks caused
by the overflow of the previous column.

4. Word 3.01 handles the combination of a bottom of page footnote, and a section break with No Break at the start of the
section, very badly. A totally unnecessary page break is inserted at the section boundary. Word 3.0 takes the even
worse action of printing the footnote in the middle of the page, between the sections. Why can't Word simply continue
to the next section on the same page, and then print the footnote on the bottom. If a user specifies this combination,
Word should assume he wants it.

5. There are problems in opening files created with Word 1, or MacWrite. I cannot convert the Macintosh technical notes
to  print  properly,  especially  TN45,  which  is  in  Word  1.05  format.  Relative  vertical  positions  of  subscripts  and
superscripts are changed when a Word version 1 file is opened. There may be some problems with headers and footers
from Word 1 documents. Font sizes change when a MacWrite document is opened.

6. The spelling checker does not flag  supercede. I am aware that because this seems to be the most commonly seen
spelling error in print, a few dictionaries have reluctantly accepted it as an alternative spelling, but supercede has not
superseded supersede. I feel that the computer software industry should expunge such non-words from computerized
spelling dictionaries. The even worse non-word, alright, is also accepted.

There appear to be numerous other problems with the spelling dictionary:
a. Header is included, but the more common word, footer, is not.
b. Many common verbs starting with re (such as renumber and repaginate) are not included, as are some common

un words.
c. There appears to be a total lack of policy with regard to certain words, that normally do not appear in print. Of 5

such 4-letter words tried, 3 were accepted, 2 rejected by the spelling checker; s**t is not accepted, but its derived
adjective is.

d. If you omit the second T from together, some very interesting alternatives will be suggested. Another word to try
is filenames.

e. Is Boston the capital of Massachuset, Massachusets, Massachusetts, or Massachusettses? All 4 forms may be
suggested if you misspell  Massachusetts. For some reason  Massachusettsan (a person from Massachusetts) is
not accepted.

f. Goodbye and liftoff are accepted only as hyphenated.
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g. San Francisco is not accepted. The spelling checker suggests San Fransisco.
h. Hoses is not accepted, but the Suggest option will suggest the same word. The same happens with sans.
i. Many 2-letter nonsense combinations are not flagged as errors.
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Despites Microsoft's claim that Word 3.02 has only additional printer support, there is a new dictionary included with
Word 3.02 that fixes many, though not all, of the spelling bugs reported here. This dictionary can be downloaded from
DL1 of the MSAPP sig on Compu$erve.

I am especially interested in receiving information about anomalies in the spelling dictionary. I feel that Microsoft,
possibly in combination with other companies, should hire one or more people with advanced degrees in English or
Linguistics to maintain a proper word list for computerized spell checking, or should work with dictionary publishes
to  produce  a  standardized  computer  spelling  list.  The  entries  in  such  a  list  should  not be  in  exact one  to  one
correspondence with the entries of a printed dictionary.

7. The spelling checker has no provision to forget a non-standard word that has been accepted by selecting No Change.
Word should accept an unrecognized word only for the duration of the spelling check, or should have an option to skip
a word without remembering it.

Microsoft has replied that Shift-Spelling... will cause the spelling checker to forget its lists of words to be
skipped and corrections to be suggested. This feature was added too late to be included in the addendum. I
feel a spell check option to stop at every occurrence of a particular misspelled word might be a desirable addition.

8. Tabs with leading underlining are not handled properly. Word uses the underscore character and is thereby restricted to
drawing underlines that are a multiple of its width. In some fonts, such as Palatino, blank space appears between
consecutive underscores if the Fractional Widths option is not enabled. Consecutive lines using the same tab show
different amounts of white space before and after the underline, a most displeasing affect. Word should simply draw a
line.

Microsoft has replied that the thinnest line that they could draw would be too thick, unless they resorted to
pure Postscript. Perhaps they should when the printer uses Postscript.

9. Formulas are often vertically mis-centered.
For example \I\su(i=1,i=n,\r(i+1))+\i\su(i=1,i=n,\r(3,i+1)) produces \I\su(i=1,i=n,\r(i+1))+\i\su(i=1,i=n,\r(3,i+1))
Notice the mis-centering of the second Sigma.

10. User dictionaries are ignored when opened from the Finder, by selecting their icons.

11. User dictionaries cannot be added to the Work menu.

12. Saving a document as text causes all formatting information to be lost in Word's internal copy of the document. It is
displayed in the default Normal style.

13. The underline character attribute is ignored for spaces at the very end of a paragraph.

Microsoft has replied that in most cases users do not want spaces at the end of a line to be underlined.
option-space can be used to force underlining. I wish to point out that the case referred to is special. Spaces at
the very end of a paragraph are normally totally redundant. The user may very well intend a trailing underline in this
special case.

14. If text without interpretable formatting information is pasted into a Word document, Word unconditionally uses New
York 12 with no character attributes. Word should, instead, use whatever font and style text typed at the insert point
would have. Formatted text, of course, should retain its special attributes (which will be exclusive ored with attributes
of the active style).

This problem also occurs if a section divider is inserted at the very beginning of a document and text is typed before it.

15. Word fails to properly hyphenate some words. Furthermore the hyphenator does not always report the same possible
points when it encounters the same word at different times. The hyphenation algorithm should be improved and a
suitable  disclaimer  should  be  placed  in  the  reference  manual  and  the  help  text  as  to  the  limits  of  automatic
hyphenation. Some words that are not properly hyphenated: antithesis, anomaly, attribute, dictionary, disclaimer,
interpretable, suitable.
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16. The keyboard menu selection method does not work with items at the bottom of long menus that must be reached by

scrolling.

17. There seems to be no way to paste values into the Find dialog box, or the search portion of the Change dialog box.
Word version 1 would copy the selected text.
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18. The current method of setting preferences is very awkward for the Show Hidden Text option, which may need to be
toggled several times in a short interval. This option can be added to the Format menu, but the reference manual does
not mention this, and the help text mentions this in the wrong section. In addition to proper documentation, there
should be a command key combination to toggle this option.

19. 400K disk upgrades appear to lack some files present in the 800K disk upgrades, the UK spelling dictionary, and some
examples. Microsoft should take note that some users with only single-sided disk capacity have hard disks. Since the
complications  resulting  from  copy  protection  are  no  longer  present,  perhaps  the  simplest  solution  to  the  dual
distribution problem would be to manufacture single-sided masters with instructions to copy to double-sided working
disks if feasible.

20. The keyboard combinations for dialog boxes do not work for those not produced by Word itself, such as the request
from the Standard File Package whether to overwrite a file with the same name. This may not be feasible to fix, but
should be properly documented.

21. Word loses track of the location of the default user dictionary, User 1. If words are added, and the changes are saved
when quitting, it will migrate out of the System folder.

22. If with the Facing Pages option set,  Page Preview is entered at page one, and the lowest icon is selected, to force
display of only one page, the first attempt to advance a page will not advance from page 1 to page 2.

23. Word does not include characters in footnotes in the reported character count after a Save.

24. Text containing the degrees symbol in the  Times font (shift-option 8) will not justify properly for the LaserWriter
unless the Fractional Widths option is enabled. This appears be a bug in the screen version of the Times font. Using a
version of Times just received from Adobe appears to cure this problem.

25. Paragraphs which use leading blanks for indentation (I am aware that this is a lousy method.) will not justify properly
for the LaserWriter unless the Fractional Widths option is not enabled.

26. In form letters, Word fails to substitute values for field names within headers, footers and footnotes. This is a gross
regression from version 1.x of Word.

27. Word 3.01  still  occasionally leaves a  Word Temp file around, though the problem is much less severe than with
version 3.0.

28. The Print Hidden Text option should be either on the Format menu, or on the Page Setup dialog, rather than on the
Print dialog. If it is not selected, hidden text should be ignored for the purposes of repagination, and should not be
show in Page Preview mode.

29. Page Setup information cannot be saved as a Glossary entry as was possible in version 1.

30. Both the reference manual, and the  Help text are incomplete, and should be updated. One necessary addition is a
complete summary  of  keyboard sequences on a  page.  I  have received  several  bug reports  for  problems that  are
properly resolved by using some of Word's arcane features.

31. Underlining of subscripts and superscripts rises and falls in accordance with the amount of vertical positioning, instead
of properly remaining at the same level below the base of the line.  This makes it impossible to properly underline such
things as titles containing chemical formulas.

32. The new key combination Command-Shift-Z, which is supposed to eliminate all special text options, does not affect
the condensed, expanded, subscript, or superscript attributes.

33. Redo Typing leaves the cursor mispositioned at the beginning instead of the end of the newly typed replacement text.

34. The hyphenator sometime selects hyphenation points that do not cause hyphenation. Apparently line widths are being
incorrectly calculated.
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35. When a page contains all or part of more than one section, Word uses both the header and the footer of the first section

present on the page. I feel that Word should use the header from the first section and the footer from the last section
present. If this is not feasible (among other thing it could result in multiple valid paginations for a document) the
subject should be properly documented.
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Furthermore when the header for the first section present contains embedded Postscript, it  will not work properly
unless the Postscript is present for all headers.

36. Index entries within footnotes are ignored; such usage is common in legal word processing.

37. The spelling checker does not show the context for misspelled words within headers, footers or footnotes.

38. Global font changes (selecting the entire document and changing the font) do not affect headers footers and footnotes.

39. There have been a few reports of crashes in Word, but only under extreme conditions. One user had crashes when
saving a very large glossary. Another user reported problems after converting an extremely (430K) large text file. I had
a crash after switching several times among 3 different (1.05, 3.0, 3.01) versions of Word.

Word sometimes runs into trouble when it runs out of memory. There appears to be no provision to gracefully quit
when such a condition occurs. I managed to produce this problem only under extreme conditions, such as having
several  desk  accessories  active,  or  running  Word under  MultiFinder  or  Switcher  with  very  complex  documents,
containing complex graphics. When an out of memory condition occurs, the startup disk is constantly active for a
while as Word desperately tries to find the needed space. Eventually either the user or the system gives up.

40. Word does not honor the Keep With Next ¶  paragraph attribute for the last paragraph of a section, when the next
sections attributes do not force a break. This construct is necessary to keep together a single column headline and the
start of its associated multi-column text.

41. When an existing file is modified and saved with Make Backup selected, the icons of file and the backup file occupy
the same place when viewed by the Finder.

42. Word has problems handling large files. There are reports of serious failures when a return occurs at exactly a 64K
boundary of a text file.

43. Word sometimes generates a page break just before a forced page break, causing a blank page. This appears to be
associated with the paragraph properties of the forced page break.

44. If a document has multiple windows, and exactly one window is split  so as to show footnotes, then closing that
window causes Word to immediately request whether to save the document rather than waiting for the last window of a
document to be closed.

45. When there is a selection the up and down arrow keys behave in a weird manner. If the selection is multi-line, the
cursor is positioned within the original selection.

46. On a Macintosh II with multiple screens, Word does not remember the positions of its moveable dialogs if they are
moved to a second screen.

47. If documents with mixed orientations are selected for printing from the Finder, Word uses the orientation of the first
document printed.

48. Word does not save files in MacWrite format properly. Some programs that can open MacWrite format files, do not
recognize files in MacWrite format that were created by Word. In particular Word fails to create a proper resource fork
for such files.

49. The glossary will not remember the format of a header or footer copied to it.

B. Changes from version 1 that may cause incompatibilities.

1. A section with  No Break  at Section Start, and a different number of columns than the preceding section is treated
differently by version 1 and version 3.

2. Tabs work differently in Word 1 and Word 3, causing some documents to be incompatible. (Similar problems exist
with MacWrite)
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3. Word 3.0 and 3.01 will break a line after a dash (Option-Hyphen or Shift-Option-Hyphen). Word version 1 would not.

4. Word 3.01 treats subscripted and superscripted text in a manner different than version 1 did.
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C. Design issues raised by users

1. Many users have complained about the lack of automatic immediate repagination in Word as compared with other
programs such as MacWrite. I am sure that speed considerations were a major consideration in  not having such a
feature; imagine having to completely repaginate a long document after typing each character, including such niceties
as renumbering footnotes. One user mentioned the utility of being able to Go To the same place by page number while
extensively editing a document.

2. Some users have complained that  Plain Text now means the style of the paragraph including any special character
attributes and the font. I feel that this is certainly a reasonable meaning, especially now that the Command-shift-Z
combination has been added to remove all character attributes, but it should be documented more strongly. At least one
user feels that the Command-shift-Z combination is extremely awkward.

3. The behavior of tabs, when typing extends beyond a tab position, is controversial. Perhaps there should be an option to
choose between typesetting tabs (ignore tab characters if the corresponding tab has already been reached - the way
Word 1 behaves), and typewriter tabs.

4. Many users have expressed strong feelings that the Word 1 versions of several shortcuts, were superior to the current
methods. Most of the new methods require more keystrokes than the methods they replaced. One user commented that
the old method for expanding glossary entries allowed double indirection. He could expand a glossary entry, and later
expand names within the expansion.

5. Several users have complained that Word does not properly indicate right margins, especially when the  Fractional
Widths option is enabled. Microsoft has acknowledged this inherent deficiency of the Macintosh, but greeking, as
done by PageMaker, might be desirable in Page Preview mode.

6. When Show ¶ is enabled, the dots used for spaces are hard to distinguish from periods. Version 1 of Word raised these
dots more than version 3.01 does.

7. When  2  paragraphs  are  combined  by  deleting  the  ¶ mark  between  them while  retaining  text  from each  of  the
paragraphs, the newly formed paragraph takes the attributes of the second paragraph. I have received a request that the
attributes of the first of the combined paragraphs be retained.

8. A user complained about the adjustment of right margins when the page width is altered.

9. Subscripting and superscripting are handled in a very annoying manner. There is no key combination to return to
normal character positioning after generating off positioned text without resetting other attributes. Selecting sub- or
superscripting from the Format Character menu does not reduce the character size but the command-shift- plus and
minus combinations do.

D. Suggestions for new or expanded features

1. There should be some provision for prefixed page numbers for documents organized by chapters. The intent is that the
chapter number prefix should appear in the table of contents and the index.

2. Page margins should be adjustable section by section, as in the MS DOS version. It may also be desirable to change
page orientation in the middle of a document.
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3. Word should support more date formats, both dynamic and non-dynamic in its documents. Some of the forms, I would

like to have some way to produce are:

3/6/87. the way it is done now
03/06/87all parts as 2 digits
87/03/06year first
6/3/87 month first
Mar. 6, 1987
6, March 1987
Friday March 6, 1987
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A user from Canada pointed out that Canadians use a European style date format.

4. I would suggest a separate  Make Backup command, as opposed to the option in the  Save As dialog box. You are
always asked whether to replace the previous file. The MS DOS version of Word creates a backup file after every save.

5. For networked systems, provide an option for the  network administrator to limit the number of times Word can be
opened simultaneously, as per licensing restrictions.

6. Word should provide styles that affect character formats only when applied (without changing paragraph formats), as
done in the MS DOS version. This would allow for example, having individual words in either Geneva or Helvetica,
while most of  the document is  in New York or  Times, and switching both pairs  of fonts easily,  or switching all
underlined words to bold easily. Section styles are also desirable.

7. Word should have provision for automatically adding change bars wherever the document is altered, and deleting all of
them at the start of a new revision. If feasible provide an option to print only changed pages.

8. Kerning pairs should be supported for LaserWriter fonts.

9. Allow multiple Word Settings files to handle cases where more than 1 person uses the same copy of Word, or where
different defaults are desirable for different document types.

Microsoft has replied that if you configure Word as desired and move the  Word Settings file out of the
System folder and/or rename it, you can get Word to start up with the requested settings by double clicking
on the moved/renamed Word Settings file. The  Word Settings files will always be saved in the system
folder after each session. I feel it might be a good idea to have a permanent option in the settings file as to where
the settings should be saved.

10. Support automated references. References are similar to footnotes, but may be referred to at more than one place in the
document,  and  consecutive  numbering is  based on the first  occurrence.  It  would be  especially  desirable  to  have
independent numbering of footnotes and references in the same document.

11. Add options to print odd or even pages only to facilitate double sided printing.

12. Allow skipping pages (start at a specified page number) at a section boundary. 

13. Provide the ability to count words in a document.

14. When adding a word to a user spelling dictionary, there should be an option to describe capitalization requirements.
When a previously unrecognized word is to be added to a user dictionary, and the word happens to be capitalized in
the document, Word should have an option to add the word without case sensitivity, as it may be start of a sentence.
While it is possible to manually enter the word without its leading capital letter, the procedure to do so is awkward and
error prone.

15. Provide facilities for easy conversion of text to the opposite case, or mixed text to all caps or all lower case.

16. Provide some capability to edit the standard dictionary.

17. Provide a thesaurus facility similar to that in the MS DOS version of Word.

18. Provide some means to automatically change quotes to true right and left quotes.

19. Provide a method to modify or expand the hyphenation dictionary and rules.  Perhaps the hyphenation dictionary
should be combined with the spelling dictionary.

20. Sell alternative spelling dictionaries for such English-like languages as Legalese and Medicalese. Provide spelling and
hyphenation  dictionaries  for  other  English-speaking  countries  such  as  Canada  and  Australia.  Sell  spelling  and
hyphenation dictionaries, if possible, for major foreign languages.

21. Add features to formula generation. Some suggestions are:
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a. Overridable user setable global defaults for  such things as amount of sub- and superscripting and relative size of

limits compare to the integral sign.
b. Multiple character Brackets (such as double bars) and "Integral signs" (such as Sum).
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c. Make fraction bars look better, especially on Postscript printers.
d. Use the special symbol-part characters of the Symbol font for large integral signs and brackets...

22. Support the function keys on the extended keyboard for the latest Macintosh models.

Microsoft has replied that this is not possible yet. Apple has  warned against assigning function key values.
A future utility will provide user mapping capabilities.

23. Allow more than 31 items on user-controlled menus. The latest systems support this, provided there are no disabled
items. Perhaps future versions of Word should use hierarchical menus; this would allow having the  Font and  Size
menus as submenus of the Format menu.

24. Provide for subheader text, included as hidden text in the body of a document, to be dynamically placed in the header
for each page. This is related to item 26 in the bugs section.

25. Provide for the temporary screen display of selected text in a large type size to assist editing without affecting the
character attributes used for printing.

26. Provide for “typesetting codes” in hidden text for specialized characters... The user who requested this was not more
explicit.

27. Allow users to change the meanings of Command key combinations. One use would be to change commonly used 3-
key combinations, such as character style changes, to 2-key combinations.

28. The topics list for the Help facility should scroll to topics starting with a letter that a user types, in a manner similar to
the scrolling feature of the Standard File Package.

29. Word should provide stronger support for graphics, including the ability to anchor a graphic to a particular position,
and have text flow around it.

30. Provide for real time spell checking.

31. Provide more facilities for boxes: Simple command to draw a box around selected text; Easy way to center a headline
within a border box.

32. Remember more default settings: Num. Lock status; ruler status of a document...

33. The Page Preview display should have icons for next page and previous page.

34. Add additional character attributes: Overline; Title Caps (Capitalize first letter of each word only)

35. Provide for showing line numbers on the screen without having to do a Page Preview.

36. The Window menu should list the windows belonging to open desk accessories.

37. Provide a capability to retain the font of index and table of contents entries, so that entries containing, for example,
characters from the Symbol font can be preserved.

38. Use system highlighting if it is other than inverting the text. The Macintosh II provides colored highlighting.

39. Allow zooming to more than 100% in page preview mode.

40. Some of the dialogs, especially the Style dialog could be made larger. Perhaps some of Word's dialog boxes could be
made resizable.

41. Provide for automatic numbering of tables figures and equations.

42. Provide a Get Info facility to store with each document such information as author, revision ...

43. The Find and Change commands should support text with format attributes.
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44. Word should be able to include pictures in more formats including ESPF (encapsulated Postscript) and TIFF.
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45. The Same as Previous option for headers and footers should be available as a permanent option, so that header and
footer changes can be propagated throughout a multi-section document.

46. When printing to a LaserWriter or other Postscript printer, Word should sort each page by font, style and size to
minimize processing within the printer.

47. The hyphenator should have options to not hyphenate words with particular text attributes (bold, italic ...)

48. Allow the insertion of unnumbered or specially numbered pages in the middle of a document, so that correction sheets
can be prepared more easily.

49. Provide a simple means of propagating the footnote separators and continuation notice from document to document.

50. Provide  an  "infinite  loop" capability  for  the  Print Merge facility  for  generating  reports  from a  list  with  global
information before and after the entire report.

51. Several of Words modal dialogs should be made modeless. On a Macintosh II there may be plenty of room to keep a
dialog such as Format Paragraph continually visible, select some text, format it…

52. Add support for vertical positioning features: vertical ruler, vertical tabs …

53. Provide a means to dynamically display the total page count. ( “page 3 of 17” in the footer)

54. Make the user interface less modal. For example specification of odd and even page headers is in the  Page Setup
dialog, the a special first page header is in Format Section.

55. Make it more easy to navigate through a large document by providing for hidden markers that can be easy to go to.

56. Add an additional paragraph specification for the height of the first line of the paragraph. A user, who was preparing a
double spaced document, noticed that the first line of each page was a line too low.

57. A user has requested the capability to define/change styles by typing directly into the Style dialog.

58. Allow changing command key synonyms in customized menus.

59. There should be an option to not print a footer on the last page of a document.

60. The default for the first header or footer should be blank, even if something is entered in the standard one.

61. When in Num. Lock mode, the Num. Lock mode on the Macintosh extended keyboard should be lit.

62. Tab leader choices should be moved to the ruler.
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